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PSoC™ 4 I2C ブートローダ  
  

About this document 

Scope and purpose 

AN86526は、PSoC™ 4の I2Cベースのブートローダについて説明します。本アプリケーション ノート
は、PSoC™ Creatorを使用して I2Cベースのブートローダ プロジェクトとブートローダブル プロジェク
トを素早く簡単に構築する方法について説明します。また、I2Cベースの組み込みブートローダ ホスト 
プログラムを構築する方法も示しています。 

関連製品ファミリ: PSoC™ 4000、4100、4200、4000S、4100S、4100S Plus、4100PS 

ソフトウェア バージョン: PSoC™ Creator 4.2 SP2以降 

関連アプリケーション ノート: こちらをクリックしてください。 

Intended audience 

このドキュメントは、PSoC™ Creatorを使って PSoC™ 4の I2Cブートローダを作成する方が対象です。 

更にサンプルコードをお求めでしょうか？以下の通りご対応いたします。 

PSoC™のサンプルコードのリストにアクセスするには、サンプルコードのウェブページをご覧くださ
い。PSoC™のビデオ ライブラリについてはここからご覧ください。 
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1 はじめに 
ブートローダは MCUシステム設計の共通部分です。ブートローダにより、製品のファームウェアが現
場で更新できます。工場では、製品へのファームウェアの初期プログラミングは一般的に MCUの Joint 
Test Action Group (JTAG) あるいは Arm® Serial Wire Debug (SWD) のインターフェースを介して実行されま
す。しかし、これらのインターフェースは常に現場でアクセスできません。 

ここはブートローディングを活用するところです。ブートローディングは、USB、I2C、UARTまたは SPI
などの標準通信インターフェースを経由してシステム ファームウェアをアップグレードすることを可能
にするプロセスです。ブートローダはホストと通信して、新しいアプリケーション コードやデータを取
得し、デバイスのフラッシュ メモリに書き込みます。 

本アプリケーション ノートは次のテーマについて説明しています。 

• PSoC™ Creatorを使用した I2Cブートローダの作成方法 
• ブートローダ ホストの項目 

− ブートローダ ホスト ツールの使用方法 
− ブートローダ ホスト システムの構築用の基本的なブロックと機能 
− PSoC™を使用した組み込み I2Cブートローダ ホストの作成方法 

本アプリケーション ノートは PSoC™ 4および PSoC™ Creator IDEの経験者を対象としています。PSoC™ 4
が初めての場合、AN79953 - Getting Started with PSoC™ 4を参照ください。PSoC™ Creatorが初めての方
は、PSoC™ Creatorホームページをご参照ください。 

本アプリケーション ノートは、読者がブートローダの概念を理解していることも想定しています。これ
らの概念をご存知ない場合、AN73854 - PSoC™ 3, PSoC™ 4 and PSoC™ 5LP Introduction to Bootloadersを
ご参照ください。ブートローディングに関わる他のアプリケーション ノート全ての一覧については、こ
こをクリックしてください。 

最後に、本アプリケーション ノートは、読者が I2Cプロトコルと PSoC™ Creatorの I2C (SCBモード) コン
ポーネントに慣れていることを想定しています。このコンポーネントに慣れていない場合は、PSoC™ 4 
Serial Communication Block (SCB) コンポーネントのデータシートを参照してください。PSoC™ Creator
内の I2C (SCBモード) コンポーネントを右クリックすることでもデータシートを取得できます。PSoC™ 
Creatorの詳細情報は以下の節を参照ください。 

1.1 用語および定義 
Figure 1はブートローダ システムの主な要素を図にしたものです。これは、製品に組み込まれたファー
ムウェアが 2つの異なる目的－通常動作とフラッシュ メモリの更新－で通信ポートを使用できなくては
ならないことを示します。フラッシュの更新方法を知っている組み込みファームウェアの部分は
bootloader (ブートローダ) と呼ばれています。 
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Figure 1 ブートローディングのシステム図 

http://www.cypress.com/?rID=78695&source=an86526
http://www.cypress.com/?id=2494&source=an86526
http://www.cypress.com/?rID=56014&source=an86526
http://www.cypress.com/index.cfm?rID=78826&source=an86526
http://www.cypress.com/index.cfm?rID=78826&source=an86526
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フラッシュ メモリを更新するデータを提供するシステムは Host (ホスト) 、更新されるシステムは 
Target (ターゲット) と呼ばれます。ホストは外部 PC (PCホスト) またはその他の MCU (組み込みホスト) 
です。 

ホストからターゲットのフラッシュにデータを転送する動作は Bootloading (ブートローディング) 、
Bootload operation (ブートロード動作) 、または略して Bootload (ブートロード) と呼ばれます。フラッ
シュにあるファームウェアは Application (アプリケーション) または Bootloadable (ブートローダブル) 
と呼ばれます。 

ブートローディングのもう 1つの用語はインシステム プログラミング (ISP) です。サイプレスは、似た
名前ですが、「In-System Serial Programmer (ISSP)」と呼ばれる異なる機能、および「Host-Sourced Serial 
Programming (HSSP)」と呼ばれる動作を備えた製品があります。詳細については、AN84858 - PSoC™ 4 
Programming Using an External Microcontroller (HSSP)をご参照ください。 

1.2 ブートローダの使用 
ブートローダの通信ポートは、通常、ブートローダと実際のアプリケーション間で共有されます。ブー
トローダを使用する最初のステップは、アプリケーションではなくブートローダが実行されるようにタ
ーゲットを操作することです。 

ブートローダが実行されると、ホストは通信チャネルを経由して「ブートロード開始」コマンドを送信
できます。ブートローダが「OK」応答を送信すると、ブートローディングが開始できます。 

ブートローディング中、ホストは新しいアプリケーション用のファイルを読み込み、フラッシュ書き込
みコマンドに変換し、それらのコマンドをブートローダに送信します。ファイル全体が送信された後、
ブートローダは新しいアプリケーションに制御を渡すことができます。 

1.3 ブートローダの機能フロー 
通常は、デバイスをリセットした時、ブートローダは最初に実行される機能です。その後、次の動作を
実行します。 

• アプリケーションを実行させる前に、その妥当性をチェックする。 
• ホストとの通信を開始するタイミングを管理する。 
• ブートロード／フラッシュ更新動作を実行する。 
• アプリケーションに制御を渡す。 

Figure 2はこの動作を示すフロー図です。 

http://www.cypress.com/?rID=81013&source=an86526
http://www.cypress.com/?rID=81013&source=an86526
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Figure 2 ブートロード処理のフローチャート 

1.4 ブートローダに移行する技術 
前に説明したように、ブートローダはリセット時に最初に実行される機能です。Figure 2に示すよう
に、ブートローダ コードはアプリケーションに制御を渡す前に、短期間ホスト (からのコマンド) を待ち
ます。このことで、ホストはブートロード動作を開始する機会を逃すことがあります。しかし、ブート
ローディングを開始する別の方法があります。それは、アプリケーションまたはブートローダブルから
ブートローダに制御をもう一度渡す方法です。 
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1.4.1 ブートローダブル API 
PSoC™ Creatorでのブートローダブル コンポーネントは、ブートローダを開始する API機能、
Bootloadable_Load() を備えています。これにより、ホストはいつでもブートローダ動作を開始でき
ます。この方法の問題は、アプリケーションの更新を実行するためにアプリケーション コードに依存し
なければならないことです。アプリケーションにブートローダへの制御移管を行わない欠陥があると、
何が起こるでしょうか？ 

1.4.2 ブートローダのカスタマイズ 
その代わりに、ブートローダはホストのために無限の時間待つほうが良いです。それを行うためには、
Bootloader_Start() を呼び出してその通常のルーチンを実行する前に、ブートローダ プロジェクトを
カスタマイズし、いくつかのユーザー入力を確認します。例えば、ブートローダは
Bootloader_Start() を呼び出す前に、UARTを監視しユーザー コマンドが発生するまで待ちます。詳
細については、AN73854 - PSoC™ 3, PSoC™ 4 and PSoC™ 5LP Introduction to Bootloadersを参照くださ
い。 

http://www.cypress.com/?rID=56014&source=an86526
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2 プロジェクト 
本節では、下記の PSoC™ Creatorプロジェクトを作成する手順について説明します。 

• I2Cブートローダ  
• ブートローダブル 
• 組み込みブートローダ ホスト  

このプロジェクトはサイプレス開発キットと一緒に使用するように設計されています。キットの選択は
ターゲット デバイスに基づきます; 詳細は付録 F - キットの選択を参照ください。キットに基づいてピン
接続を変更する必要があります。接続のタイプについては特定のキットに関する資料をご確認くださ
い。しかし、プロジェクトは他のカスタム基板に容易に適用できます。  

2.1 I2Cブートローダ 
本節では、I2Cベースのブートローダ プロジェクトを作成し構築します。このプロジェクトの特徴の 1
つはブートロード中に、キットの赤色 LEDが点滅します。次の例では、PSoC™ 4200デバイスを使用す
る I2Cブートローダ プロジェクトを示しますが、処理は他の全ての PSoC™デバイスと全く同じです。 

1. 新しい PSoC™ Creatorプロジェクトを作成して、「I2C_Bootloader_Red」と名付けます。ターゲット
PSoC™デバイスを選択し、プロジェクトの新しいワークスペースを作成します。 

Note:  PSoC™ Creator 3.1以前のバージョンである場合、プロジェクトを作成するときに
「Application Type」を指定する必要があります。アプリケーション タイプの指定は、
「Advanced」タブの隣にある「+」ボタンをクリックし、設定オプションを拡張します。
アプリケーション タイプとしてブートローダを選択します。 

2. 先頭の設計回路図に I2C (SCBモード) とブートローダ コンポーネントを追加します。LEDを点滅させ
るために、PWM (TCPWMモード) 、クロック、およびデジタル出力ピンのコンポーネントを追加しま
す。Table 1に示すように、コンポーネントの名前を変更します。 

Table 1 I2C_Bootloader_Redプロジェクト コンポーネント名 

コンポーネント 名称 
Bootloader_1 Bootloader 
I2C_1 I2C 
PWM_1 PWM 
Clock_1 Clock 
Pin_1 Pin_LED 

3. ブートローダを設定するために、コンポーネントをダブルクリックします。Figure 3に示すように、
Communication component (通信コンポーネント)として I2Cを選択します。他のパラメーターは初
期設定のままにしてください。これらの設定パラメーターの詳細については、「Bootloader 
Component datasheet」を参照してください。  

Note: パラメーターの「Wait for command time」 (コマンド タイムの待ち時間) は 2秒に設定し
ます。ブートローダの待機時間の詳細については、ブートローダ コンポーネント データ
シートの「Wait For Command Time」を参照してください。 

http://www.cypress.com/?rID=71586&source=an86526
http://www.cypress.com/?rID=71586&source=an86526
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Figure 3 ブートローダの設定 

4. I2C (SCBモード) コンポーネントを設定するために、それをダブルクリックします。デフォルトで
は、モードを「Slave」に、データレートを 100kbps に、スレーブ アドレスを 8に設定します。別の
アドレスを使用する場合は、スレーブ アドレス ボックスに入力します。他のパラメーターは初期設
定のままにしてください。Figure 4に、I2Cコンポーネントの基本設定タブを示します。 

 

 

Figure 4 基本 I2C (SCBモード) のコンフィギュレーション 
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I2C (SCBモード) コンポーネントは、I2C バス (オープンドレイン、Low駆動) を使用するために自動的に
設定されるピン コンポーネントを含んでいます。10ページの Figure 8に示すように、外部のプルアッ
プ抵抗を追加して、それらを実際の端子に割り当てる (10ページのステップ 8) 必要があります。 

5. PWM (TCPWMモード) コンポーネントを設定するために、ダブルクリックします。「Period」を 254
に、「Compare」を 127に設定します。他のパラメーターは初期設定のままにしてください。Figure 
5に、PWM (TCPWMモード) コンポーネントの基本コンフィギュレーション タブを示します。 

 

 

Figure 5 基本 PWM (TCPWM モード) の設定 

6. ピン コンポーネントに対しては、それらのパラメーターを初期値のままにします。Figure 6に示す
ように、配線を使用して PWMコンポーネントの「line」端子にピンを接続します。 

 

 

Figure 6 ピン接続 
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7. クロック コンポーネントを設定するために、ダブルクリックします。Figure 7の通りに、
「Frequency」を 200Hzに設定します。他のパラメーターは初期設定のままにしてください。 

 

 

Figure 7 クロックのコンフィギュレーション 

抵抗と LEDが注釈コンポーネントとして追加された後、プロジェクトのトップ デザインは Figure 8のよ
うになります。 
 

 

Figure 8 I2C_Bootloader_Red プロジェクトのトップ デザイン 

8. I2Cピン コンポーネントを実際の端子に割り当てます。「Workspace Explorer」ウィンドウ内で、
「I2C_Bootloader_Red.cydwr」ファイルをダブルクリックして、「Pins」タブをクリックします。ピ
ンの割り当てはデバイスに依存します。詳細はデバイス データシートを参照ください。例えば、
CY8CKIT-042の PSoC™ 4200デバイスでは Figure 9のように、そして CY8CKIT-040の PSoC™ 4000デ
バイスでは Figure 10のようにピンを割り当てます。 

http://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-psoc-4-pioneer-kit?source=search&keywords=CY8ckit-042
http://www.cypress.com/products/psoc-4200?source=search&keywords=CY8ckit-042
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-040-psoc-4000-pioneer-development-kit?source=search&keywords=cy8ckit-040
http://www.cypress.com/products/psoc-4000?source=search&keywords=psoc%204000
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Figure 9 CY8CKIT-042用の I2Cピンの割り当て 

 

 

Figure 10 CY8CKIT-040用の I2Cピンの割り当て 

9. Bootloader_Start()関数を main()関数に追加します。この API関数はブートロード動作の全てを行
います。これは、リターンしません; ソフトウェアのデバイスリセットで終了します。そのため、こ
の関数を呼び出した後のコードは実行されません。Code Listing 1に示すように、2つの API関数を
main()に追加して PWMを初期化します。このコンポーネント APIの詳細については、「TCPWM 
Component datasheet」を参照してください。 

Code Listing 1 ブートローダ内の PWMの初期化 

Int main() 

{ 

  /* Initialize PWM */ 

  PWM_Start(); 

  PWM_TriggerCommand(PWM_MASK, 

                     PWM_CMD_START); 

 

  Bootloader_Start(); 

 

  for(;;) 

  { 

    /* Place your code here. */ 

  } 

} 
 

10. プロジェクトをビルドし、ターゲット デバイスの選択に応じた指定するキットにプログラムしま
す。 

http://www.cypress.com/?rID=78825&source=an86526
http://www.cypress.com/?rID=78825&source=an86526
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2.2 ブートローダブル 
ここでは、2つのブートローダブル プロジェクトを作成します。最初のプロジェクトは、PSoC™開発キ
ット上にある緑色 LEDを点滅させます。2番目のプロジェクトは、ブートローダブル プロジェクトから
ブートローダ プロジェクトに入る方法を説明し、キットの青色 LEDを点滅させます。 

Note: 27ページの Figure 31と 27ページの Figure 32に示すように、CY8CKIT-042と CY8CKIT-042
上には RGB LEDがあります。ここでは、緑色 LEDと青色 LEDは、プロジェクトが実行し
ていることを示すために使用されます。 

2.2.1 Bootloadable_Greenプロジェクト– 例 1 
本節では最初のブートローダブル プロジェクトを作成する手順について説明します。 

1. アプリケーション型のブートローダブルの新しい PSoC™ Creatorプロジェクトを作成します。
「Bootloadable_Green」プロジェクトと名付けます。本プロジェクトと I2C_Bootloader_Redプロジ
ェクト用のデバイスは同じである必要があります。 

2. 本プロジェクトに対しては、ブートローダブル コンポーネントとデジタル出力ピン コンポーネント
が必要です。2つのコンポーネントをトップ デザイン回路図に追加します。コンポーネントを Table 
2の通りに名付けます。 

Table 2 「Bootloadable_Green」プロジェクトのコンポーネント名 

コンポーネント 名称 
Bootloadable_1 ブートローダブル 
Pin_1 Pin_LED 

 

3. ブートローダブル コンポーネントをダブルクリックして、設定を行います。 

ブートローダブル プロジェクトは常にブートローダ プロジェクトの.hexファイルにリンクします。プロ
ジェクトをリンクするためには、Dependenciesタブに移動して、Figure 11に示すように、ブートロー
ダブルを I2C_Bootloader_Red.hexファイルにリンクします。ブートローダブル コンポーネント設定の詳
細については、Bootloadable Component datasheetを参照してください。 

http://www.cypress.com/CY8CKIT-042
http://www.cypress.com/CY8CKIT-040
http://www.cypress.com/CY8CKIT-040
http://www.cypress.com/?rID=71586&source=an86526
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Figure 11 ブートローダブル コンポーネントの設定 

I2C_Bootloader_Red.hexファイルをブートローダ プロジェクトの Debugまたは Releaseフォルダで見つ
けられます。 

1. PSoC™ 4000、4100、4200の場合 

..\I2C_Bootloader_Red.cydsn\CortexM0\ARM_GCC_541\Debug\I2C_Bootloader_Red.hex 

2. PSoC™ 4000S、4100S、4100S Plus、および 4100PSの場合 

..\I2C_Bootloader_Red.cydsn\CortexM0p\ARM_GCC_541\Debug\I2C_Bootloader_Red.hex 

3. ピン コンポーネントを設定するために、それをダブルクリックします。Figure 12に示すように、
HW Connectionを無効にします。Figure 13に示すように、駆動モードを Strong Driveに設定しま
す。 

 

 

Figure 12 ピン コンポーネントの設定 - 「Type」タブ 
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Figure 13 ピンコンポーネントの設定 – 「General」タブ 

LED用の注釈コンポーネントを追加した後、トップ デザインが終了します; Figure 14と同じようになり
ます。 
 

 

Figure 14 Bootloadable_Greenプロジェクトのトップ デザイン 

4. 下記のコードを main.cに追加して LEDを点滅させます。 

void main() 

{ 

for(;;) 

  { 

      /* Toggle the LED */ 

Pin_LED_Write(~Pin_LED_Read()); 

 

      /* Delay 1 second */ 

CyDelay(1000u); 

  } 

} 

5. ピン コンポーネントを実際の端子に割り当てます。「Workspace Explorer」ウィンドウで、
Bootloadable_Green.cydwrファイルをダブルクリックして、ピンを割り当てます。ピンの割り当てに
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ついては、キットのユーザー ガイドを参照ください。例えば、Figure 15には CY8CKIT-042キット基
板の、そして Figure 16には CY8CKIT-040キット基板用のピン割り当てを示します。 

 

 

Figure 15 CY8CKIT-042用に Bootloadable_Greenプロジェクトのピンの割り当て 

 

 

Figure 16 CY8CKIT-040用の Bootloadable_Greenプロジェクトのピンの割り当て 

6. プロジェクトを構築します。ブートローダブル プロジェクトが構築されると、PSoC™ Creator
は.cyacdファイルを作成します。このファイルはターゲットにブートロードされます。このファイル
と内容についての詳細は、付録 Bを参照してください。 

ここで、PSoC™ Creatorを使ってこのプロジェクトを PSoC™にブートロードしてみましょう。 

2.2.2 PCのホストを使用してブートローディング 
ブートローダ ホスト実行可能ファイルは、PCホストからアプリケーションをブートロードするために
PSoC™ Creatorに備えられています。PSoC™ 4および PSoC™アナログ コプロセッサのキットは基板搭載
の PSoC™ 5LPを使用する USB-I2Cブリッジを実装します。このブリッジは、Figure 17の CY8CKIT-042キ
ット用および Figure 18の CY8CKIT-040キット用のように、PCをブートローダにインターフェースする
ために使用することができます。 
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USB

D+
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Figure 17 CY8CKIT-042用の PCホストを使用してブートローディング 
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Figure 18 CY8CKIT-040用の PCのホストを使用してブートローディング 

http://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-psoc-4-pioneer-kit?source=search&keywords=cy8ckit042
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-040-psoc-4000-pioneer-development-kit?source=search&keywords=cy8ckit040
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-psoc-4-pioneer-kit?source=search&keywords=cy8ckit-042
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-040-psoc-4000-pioneer-development-kit?source=search&keywords=cy8ckit-040
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Note: すべての PSoC™ 4キットで、ピンは基板搭載の PSoC™ 5LP SCLに接続し、SDAピンには内
部プルアップ抵抗があります。そのため、外部のプルアップを使用する必要がありませ
ん。I2Cピン接続の詳細情報はキットのユーザー ガイドを参照ください。 

Note: ブートロードのために、CY8CKIT-002 MiniProg3を USB-I2Cブリッジとして使用することも
できます。詳細については、「MiniProg3 User Guide」知識ベース記事「MiniProg3 
Connections for Bootloading Over I2C」を参照してください。 

PSoC™ 4200デバイス用のブートローダ ホスト プログラムを使用して、アプリケーションをブートロー
ドするには、以下の手順に従ってください。手順は、正確に他の PSoC™ファミリについても全く同じで
す。前述した通り、ブートロード動作を開始する前に、PSoC™デバイスにブートローダ プロジェクトを
プログラムする必要があります。 

1. Figure 19に示すように、先ず CY8CKIT-042を USBケーブル (電源を供給) を介して PCに接続しま
す。  

 

 

Figure 19 USBケーブルを CY8CKIT-042の J10に接続 

2. PSoC™ Creatorで「 Tools > Bootloader Host」に移動し、ブートローダ ホスト ツールを開きます。 
3. Figure 20に示すように、ブートローダ ホスト アプリケーションの I2Cの設定は、ブートローダ プロ
ジェクトの I2C (SCBモード) コンポーネント設定 (8ページの Figure 4) と同じであることを確認してく
ださい。 

Note: USBケーブルを介してキットに接続した後、ブートローダ ホスト GUIに KitProgの情報が
ない場合、Filtersをクリックして、Show I2C Devicesが有効になっていることを確認して
ください。 

http://www.cypress.com/?rID=38154&source=an86526
http://www.cypress.com/?rID=38154&source=an86526
http://www.cypress.com/?id=4&rID=51738&source=an86526
http://www.cypress.com/?id=4&rID=51738&source=an86526
http://www.cypress.com/?rid=77780&source=an86526
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Figure 20 ブートローダのホスト アプリケーション 

4. Fileボタンを押して、ブートローダブル プロジェクトの Debugまたは Releaseフォルダ内のブート
ローダブル ファイル Bootloadable_Green.cyacdを選択します。 
− PSoC™ 4000、4100、4200の場合 

..\Bootloadable_Green.cydsn\CortexM0\ARM_GCC_541\ Debug\Bootloadable_Green.cyacd  

− PSoC™ 4000S、4100S、4100S Plus、および 4100PSの場合 

..\Bootloadable_Green.cydsn\CortexM0p\ARM_GCC_541\ Debug\Bootloadable_Green.cyacd 

5. デバイスをブートロードするには、Programボタンを押します。Figure 21と同じような画面が開き
ます。 
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Figure 21 ブートローダブル プロジェクトのダウンロード 

6. ブートローダブル プロジェクトがブートロードに成功した後、ソフトウェアのリセットが発生し、
デバイスは新しいアプリケーションを実行し始めます。キットの RGB LEDが緑色に点滅します。 

他のアプリケーションをブートロードするには、デバイスをリセット (PSoC™開発キットのリセットボタ
ンを押して離す) して、ブートローダをアクティブにします。そして、8ページの Figure 3でセットされ
た「Wait for command time」の期間内にブートローダ ホストのプログラム ボタンを押します。ブート
ローダの待機時間の詳細については、Bootloader and Bootloadable Component datasheet内に記載され
ている「Wait for Command Time」の項を参照してください。 

2.2.3 Bootloadable_Blueプロジェクト – 例 2 
現在のブートローダブル プロジェクトが実行中に、新しいプロジェクトをブートロード (アプリケーシ
ョンのアップグレード) したい場合、ブートローダブル プロジェクトは API関数 Bootloadable_Load() 
を呼び出すことでブートローダを起動します。 

この例では、ボタンを押すと、Bootloadable_Load() 関数が呼び出されます。本節ではこのブートロ
ーダブル プロジェクトの作成手順を説明します。 

1. 例 1と同じように Bootloadableのアプリケーション タイプの新しい PSoC™ Creatorプロジェクトを
作成します。「Bootloadable_Blue」プロジェクトと名付けます。本プロジェクトと
I2C_Bootloader_Redプロジェクト用の PSoC™デバイスは同じである必要があります。 

2. 本プロジェクトでは、1つのブートローダブル コンポーネント、2つのピン コンポーネントおよび 1
つの割り込みコンポーネントが必要です。これらのコンポーネントをトップ デザイン回路図に追加
し、Table 3の通りに名前を付けてください。 

http://www.cypress.com/?rID=71586&source=an86526
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Table 3 ブートローダブル コンポーネント名 

コンポーネント 名称 

Bootloadable_1 ブートローダブル 
Pin_1 (デジタル入力ピン) Pin_StartBootloader 
Pin_2 (デジタル出力ピン) Pin_LED 
isr_1 isr_EnterBootloader 

3. 13ページの Figure 11に示すように、ブートローダブル コンポーネントをブートローダ プロジェク
トにリンクします。 

4. デジタル入力ピン「Pin_StartBootloader」はアプリケーションからブートローダに切り替えるために
使用されます。このピンに接続されたボタンを押すと、アプリケーションは API関数 
Bootloadable_Load()を呼び出すことでブートローダを送り込みます。ブートローダは、ホストが
ブートロード動作を開始するのを無期限に待ちます。 

DVKボタンを押すとグランドに短絡するので 、Figure 22に示すようにピンの駆動モードを Resistive 
Pull Upに設定します。また、Figure 23に示すように、その立ち下がりエッジで割り込みが生成する
ように設定します。ボタンを押すと、割り込みが生成されます (ボタンが開放されていると割り込み
は生成されません)。 

最後に、Typeタブをクリックして、HW Connectionを無効にします。 
 

 

Figure 22 デジタル入力ピンの設定 
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Figure 23 デジタル入力ピンの設定 

5. デジタル出力ピン Pin_LED は LEDを制御するために使用されます。その設定は例 1の Pin_LEDの設
定と同じです。Figure 12と Figure 13を参照してください。 

6. ISRのコンポーネント「isr_EnterBootloader」を「Pin_StartBootloader」の割り込み端子 (irq) に接続し
ます。ボタンと LED用の注釈コンポーネントが追加された後、トップ デザインが終了します。同様
に Figure 24のようになります。 

 

 

Figure 24 Bootloadable_Blueプロジェクトのトップ デザイン 

7. ピンコンポーネントを実際の端子に割り当てます。Workspace Explorerウィンドウで、
Bootloadable_Blue.cydwrファイルをダブルクリックして、ピンを割り当てます。ピンの割り当てにつ
いてはサイプレス キット用のキット ユーザー ガイドを参照ください。Figure 15は CY8CKIT-042キ
ット基板用の、そして Figure 16は CY8CKIT-040キット基板用のピンの割り当てを示します。 

http://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-psoc-4-pioneer-kit?source=search&keywords=cy8ckit042
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-040-psoc-4000-pioneer-development-kit?source=search&keywords=cy8ckit040
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Figure 25 CY8CKIT-042の Bootloadable_Blueプロジェクトのピンの割り当て 

 

 

Figure 26 CY8CKIT-040の Bootloadable_Blueプロジェクトのピンの割り当て 

8. プロジェクトを構築します。これで、ISRコンポーネント APIファイルが作成されます。そして、コ
ードを割り込みサービス ルーチンに追加して、変数 bootload_flagをセットします。コードは以下
のようになります。 

CY_ISR(isr_EnterBootloader_Interrupt) 

{ 

      /* Place your Interrupt code here. 

      */ 

      /* `#START 

      isr_EnterBootloader_Interrupt` 

      */ 

  bootload_flag = 1u; 

  Pin_StartBootloader_ClearInterrupt(); 

        /* `#END` */ 

} 

Note: 変数 bootload_flagは、main.cで定義されているので、isr_EnterBootloader.cファイル内
で外部変数として宣言しなければなりません。また、ビルド警告を回避するために、
isr_EnterBootloader.cファイル内に #include <device.h>を追加します。 

9. 完成した Bootloadable_Blueプロジェクトは本アプリケーション ノートと関連付けられています。こ
の関連するプロジェクトの main.cファイルから、ユーザー プロジェクトの main.cファイルにリスト
されたコードを挿入してください。 
main()関数は継続的に bootload_flag 変数をチェックします。変数がセットされると、main()関
数は、LEDを消し、ブートローダを起動するために API関数 Bootloadable_Load()を呼び出しま
す。 

10. プロジェクトを再び構築します。PCのホストを使用してブートローディングの節に記載された手順
の通りに、ブートローダブル プロジェクト Bootloadable_Blue.cyacd をダウンロードします。ターゲ
ット上のキットの RGB LEDは青色に点滅します。 

11. SW2スイッチを押してブートローダに入ると、キットの RGB LEDが赤色に点滅します。 
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12. ブートローダ ホストのプログラムを開始し、Bootloadable_Green.cyacdのような異なるブートローダ
ブルファイルを選択して、Programボタンを押します。新しいアプリケーションがブートロードに
成功した後、キットの RGB LEDは緑色に点滅します。 

Note: 再度ブートロードするには、デバイスをリセットし、新しい.cyacdファイルを素早くダウ
ンロードする必要があります。この理由は、Bootloadable_Green アプリケーションがブー
トローダを起動するための Bootloadable_Load() の呼び出し関数を持っていないため
で、ブートローダはリセット時にのみ呼び出すことができます。  

2.3 I2Cブートローダ ホスト 
用例のプロジェクトを研究することに加えて、ブートローダ ホスト プログラムの一般的な構造を理解
することは、自分のブートローダ ホスト システムを構築するのに役立ちます。 

2.3.1 ブートローダ ホスト プログラム 
Figure 27はブートローダ システムのプロトコル レベルでのダイヤグラムを説明します。ブートローダ
のホストとターゲットはそれぞれ 2つのブロック – コアと通信層があります。 
 

Bootloader Host

Bootloader Target

Bootloader Host Core

Communication Layer Communication Layer

Bootloader Target Core

UI Application

command.c / .h

I2C

api.c / .h

api2.c / .h

parse.c / .h

 

Figure 27 ブートローディング時のプロトコル レベルでのダイヤグラム 

ブートローダ ホスト コアは、すべてのブートロード動作を実行します。これは、ターゲットにコマン
ド パケットとフラッシュ メモリへのデータを送信します。ターゲットからの応答で、ブートロードを
実施し続けるかどうか決定します。 

ブートローダのターゲット コアはホストからのコマンドを解読し、フラッシュ ルーチン (行の消去、行
のプログラム、行の確認など) を呼び出すことでコマンドを実行し、応答パケットを形成します。 

ホストとターゲットの両方にある通信層はブートロードのプロトコルをサポートする物理層です。これ
らは、この関数を実行する通信プロトコル (I2C) 固有の APIを含んでいます。この層はホストとターゲッ
ト間のプロトコル パケットの送受信を担当します。 
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2.3.2 ブートローダ システム API 
PSoC™ Creatorは、ブートローダ プロジェクトを構築する時にブートローダのターゲット コアと通信層
用に全ての API を自動的に生成します。 

PSoC™ Creatorには、この位置で見つけることができるコアに対応したホスト側の APIも用意されていま
す。 

<インストール フォルダ> \ PSoC Creator \ 4.2 \ PSoC Creator \ cybootloaderutils 

これら APIファイルの詳細情報については、付録 Dを参照してください。 

唯一書き込む必要があるコードは、ファイルのペア communication_api.c / .h内にある、通信層に対応し
たホスト側の API関数です。関数は 4つあります: OpenConnection()、CloseConnection()、
ReadData()、および WriteData()。cybtldr_api.hにある「CyBtldr_CommunicationsData」のデータ構造
において、関数ポインタがこれらの関数にポイントします。 

このプロジェクトは、Bootloadable_Blueプロジェクト – 例 2を使用して、スイッチの押下でブートロ
ーダを起動するのに必要な.cyacdファイルを作成しています。本プロジェクト用の.cyacdファイルを作
成して、Bootloadable_BlueLED.cyacdのファイル名に変えます。同様に、Pin_LEDを P0[2]に割り当てる
ことで Bootloadable_GreenLED.cyacdを作成します。これら 2つのファイルは、クイック リファレンスと
して、アプリケーション ノートで提供されます。 

2.3.3 I2Cブートローダ ホスト プロジェクトの作成手順 
本節では、PSoC™を使用して、他の PSoC™デバイスをブートロードできる、組み込み I2Cブートローダ 
ホスト プロジェクトの作成方法について説明します。このプロジェクトにより、スイッチを押下するご
とに、ホストは 2つの異なるブートローダブル ファイル (.cyacd ファイル) をブートロードできます。 

1. 新しい PSoC™ Creatorプロジェクトを作成します。PSoC™デバイスを選択し、プロジェクトを
I2C_Bootloader_Hostと命名してプロジェクトの新しいワークスペースを作成します。 

2. ブートローダ プロジェクトに I2Cスレーブがあるので、ホスト プロジェクトには I2マスターが必要
です。そこで、I2C (SCBモード) コンポーネントをトップ デザイン回路図に追加します。また、デジ
タル入力ピン、割り込み、UART (SCBモード) コンポーネントもトップ デザイン画面に追加します。
コンポーネントを Table 4の通りに名付けます。 

Table 4 I2C_Bootloader_Hostプロジェクトのコンポーネントリスト 

コンポーネント 名称 
I2C_1 I2C 
Pin_1 Pin_Switch 
isr_1 ISR_Switch 
UART_1 UART 

3. I2C コンポーネントを設定するために、ダブルクリックします。そして、それをマスター モードに設
定します。デフォルトでは、データレートは 100 Kbpsです。 

4. デジタル入力ピンの Pin_Switchは、ホスト内でのブートロード動作を起動するのに使用されます。
キットのボタンを押すと、ピンがグランドに短絡します。そのため、このピンがプルアップ抵抗を
持つように設定し、その立下りエッジで割り込みが起きるようにする必要があります。ISR_Switchコ
ンポーネントをこのピンの割り込み出力 (irq) に接続します。 

5. UARTはブートローディングの状態またはエラーコードを PCに転送するために使用されます。パラ
メーターはデフォルト設定 (ボーレート: 115200 kbps、データビット: 8ビット、パリティ: 無し、スト
ップ ビット: 1ビット) のままにしておきます。 
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ここでは、ボタン用の注釈コンポーネントが追加されて、このプロジェクトのトップ デザインは、
Figure 28と同じようになります。 

 

 

Figure 28 I2C_Bootloader_Hostプロジェクトのトップ デザイン 

6. 入力と出力のピンを割り当てます。「Workspace Explorer」ウィンドウで、
I2C_Bootloader_Host.cydwrファイルをダブルクリックし、ピンを割り当てます。ピンの割り当てにつ
いては、デバイス データシートまたはサイプレス キット用のキット ユーザー ガイドを参照くださ
い。Figure 29は CY8CKIT-042用のピン割り当てを示します。 

 

 

Figure 29 I2C_Bootloader_Host プロジェクトのピン割り当て 

7. ISRコンポーネントの APIファイルを生成するためにプロジェクトを構築します。コードを割り込み
サービスルーチンに追加して、変数 switch_flagをセットします。コードは以下のようになりま
す。  

CY_ISR(ISR_Switch_Interrupt) 

{ 

/* Place your Interrupt code here. 

 */ 

/* `#START ISR_Switch_Interrupt` */ 

  switch_flag = 1u; 

Pin_Switch_ClearInterrupt(); 

/* `#END` */ 

} 

Note: switch_flagは、main.c内で定義されているため、ISR_Switch.c内で外部変数として宣言
する必要があります。また、ビルド警告を回避するために、ISR_Switch.cファイル内に
#include <device.h>を追加します。 

http://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-psoc-4-pioneer-kit?source=search&keywords=cy8ckit-042
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8. ファームウェアをこのプロジェクトに追加します。I2C_Bootloader_Hostプロジェクトは本アプリケ
ーション ノートに添付されています。この関連するプロジェクトの main.cファイルから、ユーザー 
プロジェクトの main.cファイルにリストされたコードを挿入してください。 
main.cにある main()関数は連続的に switch_flag変数をチェックします。フラグをセットする
と、ブートローディングが起動されます。main.cファイルは device.h内で定義される
BootloadStringImage()への関数呼び出しを備えています。この関数はブートローダ ホスト APIフ
ァイル (ホスト コア、Figure 27を参照) を使用して.cyacdファイルをブートロードします。 
main() 関数は「toggle_appcode」と呼ばれる別の変数があります。ボタンを押すたびに、「0」と
「1」を交互に繰り返します。これにより、ホストはブートローダブル ファイルを交換に選択しま
す。 

9. 前に説明した通りに、ブートローダホストコアは 4つの APIファイルでビルドされています。これら
のファイルは全てのホスト ブートロード動作を行います。ユーザーは、ユーザーのプロジェクト内
にこれらのファイルを含める必要があります。これらの APIファイルは次の場所に格納されます。 
< install folder > \ PSoC Creator \ 4.2 \ PSoC Creator \ cybootloaderutils 
Figure 30に示すように、これらのファイルを追加するために、Workspace Explorerに移動し、プロ
ジェクト名を右クリックして、Add > Existing Itemを選択します。PSoC™ Creatorが提供する次のフ
ァイルを追加します: cybtldr_api.c / .h、cybtldr_command.c / .h、 cybtldr_parse.c / .h、cybtldr_utils.h。 

 

 

Figure 30 APIファイルの追加 

10. APIファイルのブートローディングに加えて、ホストは通信層のサポートも必要です。このサポート
は communication_api.c / .hファイルを追加することで提供されます。ユーザーは、本アプリケーショ
ン ノートに関連する I2C_Bootloader_Hostプロジェクトからこれらのファイルの内容を取り込んで構
いません (これらのファイルをプロジェクトに追加するには、前述のステップに従ってください) 。
本アプリケーション ノートに添付されたプロジェクトからコピーして、これらのファイルを更新し
ます。 

11. ブートローダブル ファイルをホストシステムに組み込みます。ブートローダブル ファイルを構築す
ると、.cyacdファイルが生成されます。ファイルは.hexの出力ファイルと似ています。.cyacdファイ
ルの詳細情報については、付録 Bを参照してください。 
各ラインが配列の要素であるように、このファイルの内容を文字列の配列の形式でコピーします。2
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つのブートローダブル ファイルを持っているので、「StringImage_0」と「StringImage_1」と名付け
られた 2つの配列を定義する必要があります。各配列に対しては、その配列にある行数を格納する
マクロを定義します。これらの配列を StringImage.hという別のファイルに定義します (文字列を定義
する前に、このファイルをプロジェクトに追加する必要があります) 。 
本アプリケーション ノートに関連する I2C_Bootloader_Hostプロジェクト内にある StringImage.hフ
ァイルを参照してください。 
プロジェクトを構築して、サイプレス キットの PSoC™の中にプログラムします。 
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3 プロジェクトのテスト 

Note: Figure 31と Figure 32に示すように、CY8CKIT-042と CY8CKIT-040キット上の LEDは RGB 
LEDです。ここでは、緑色と青色の LEDはどちらのブートローダブルが現在実行中である
かを示すために使用されます。 

 

 

Figure 31 CY8CKIT-042用の RGB LEDの回路図 

 

 

Figure 32 CY8CKIT-040用の RGB LEDの回路図 

3.1 キットを設定 
プロジェクトをテストするために、次のようにキットを設定します。 

ターゲット PSoC™キットの場合、以下の手順に従ってください。 

1. ターゲットを USBケーブル (電源を供給) で PCに接続します。 
2. I2C_Bootloader_Redプロジェクトで PSoC™ターゲットをプログラムします。 

ホスト PSoC™キットの場合、次の追加ステップを実行してください。 

1. ホストを USBケーブル (電源を供給) で PCに接続します。 
2. I2C_Bootloader_Hostプロジェクトでホスト PSoC™をプログラムします。 
3. PCの Tera Termなどの任意のシリアル ポート ビューワを開いて、ブートローディングの情報を表示
します。  

例えば、ホスト CY8CKIT-042キットの場合、PSoC™ 4内で割り当てられた Rx (P0[4]) と Tx (P0[5]) のピン
を拡張ヘッダ J8にあるピン 10とピン 9へ接続します。詳細については、CY8CKIT-042 PSoC™ 4 Pioneer 
Kit Guideを参照してください。I2C_Bootloader_Hostプロジェクトでプログラムし、シリアル ポート ビ
ューワを開いてブートローディングの情報を表示します。 

ホスト キットとターゲットの接続の場合、以下の手順に従ってください。 

1. ホスト キットの SCLと SDAのピンをターゲット キットのそれぞれの SCLと SDAのピンに接続しま
す。 

2. キットのグランド ピンを共に短絡します。 

例えば、CY8CKIT-042ホストおよび CY8CKIT-042ターゲットの場合、Figure 33に示すように、ホストの
P4[0] (SCL) と P4[1] (SDA) のピンをターゲットのそれぞれの P3[0] (SCL) と P3[1] (SDA) のピンに接続しま

http://www.cypress.com/?rid=77780&source=an86526
http://www.cypress.com/CY8CKIT-040
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-psoc-4-pioneer-kit?source=search&keywords=cy8ckit-042
http://www.cypress.com/?rid=77780&source=an86526
http://www.cypress.com/?rid=77780&source=an86526
http://www.cypress.com/CY8CKIT-042
http://www.cypress.com/CY8CKIT-042
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す。CY8CKIT-042ホストおよび CY8CKIT-040ターゲットの場合は、Figure 34に示すように、ホストの
P4[0] (SCL) と P4[1] (SDA) のピンをターゲットのそれぞれの P1[2] (SCL) と P1[3] (SDA) のピンに接続しま
す。キットのグランド ピンを共に短絡します。 

Figure 33と Figure 34にこれらの接続を示します。 
 

Hosta

P0[7] SW2

CY8CKIT-042

PSoC 4

Target

P0[7] SW2

SCLb

SDAb

GND

P4[0] P3[0]

P4[1] P3[1]

CY8CKIT-042

 a.  The Bootloading Status / Error Code is transferred to PC via USB-UART Bridge in CY8CKIT-042
 b.  P3[0]/P3[1] and P4[0]/P4[1] are pulled up with 2.2 KΩ resistors in CY8CKIT -042 

PSoC 4

USB-I2C/UART BridgeUSB-I2C/UART Bridge

 

Figure 33 ホスト／ターゲットの接続 (CY8CKIT-042のターゲット) 

 

Hosta

P0[7] SW2

CY8CKIT-042

PSoC 4
(CY8C40xx)

Target

P0[7]

SCLb

SDAb

GND

P4[0] P1[2]

P4[1] P1[3]

CY8CKIT-040

 a.  The Bootloading Status / Error Code is transferred to PC via USB-UART Bridge in CY8CKIT-042
 b.  P1[2]/P1[3] and P4[0]/P4[1] are pulled up with 2.2 KΩ resistors in CY8CKIT-040 and CY8CKIT -042 
respectively

PSoC 4
(CY8C42xx)

USB-I2C/UART BridgeUSB-I2C/UART Bridge

 

Figure 34 ホスト／ターゲットの接続 (CY8CKIT-040のターゲット) 

3.2 結果の検証 
キットが設定された後、用例のプロジェクトを以下のようにテストできます。 

• ホスト キット上のボタン (CY8CKIT-042用の P0[7]) を最初に押すと、Bootloadable_GreenLED.cyacdフ
ァイルはターゲット PSoC™にブートロードされます。成功して完了すると、「Bootloaded. Led blinks 
with green color on Target」のメッセージがシリアル ポート ビューワで表示され、ターゲットの緑色
LEDが点滅します。 

• 次のブートローディング動作のために、ターゲット キットのボタン (CY8CKIT-042の場合 P0[7]) を押
します。ボタンを押したのを検出した時に PSoC™はブートローダに入ります。PSoC™ 4はブートロー
ダを実行している時に赤色の LEDが点滅します。 

• ホスト キット上のボタンを次に押すと、Bootloadable_BlueLED.cyacdファイルはターゲットの PSoC™
にブートロードされます。成功して完了すると、「Blue LED blinks on the target」のメッセージがシ
リアル ポート ビューワで表示され、ターゲットの青色 LEDが点滅します。 

http://www.cypress.com/CY8CKIT-042
http://www.cypress.com/CY8CKIT-040
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-psoc-4-pioneer-kit?source=search&keywords=cy8ckit-042
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-psoc-4-pioneer-kit?source=search&keywords=cy8ckit-042
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4 まとめ 
本アプリケーション ノートは I2Cを通信インターフェースとして使用して、PSoC™をブートロードする
方法について説明しました。また、ブートローダホストの基本的な構成ブロックも紹介し、組み込み I2C
ブートローダ ホストの構築方法を示しています。 

ブートローダはフィールドのアップグレードを実施するための標準的な方法です。ユーザーにとって
は、全ての設定を行う PSoC™ Creatorで PSoC™用にブートローダを簡単に作成できます。 

詳細情報については、付録および PSoC™ 4のテクニカル リファレンス マニュアルをご覧ください。 

http://www.cypress.com/documentation/technical-reference-manuals/psoc-4100-and-4200-family-psoc-4-architecture-technical
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5 関連アプリケーション ノート 
ブートローダとフラッシュのプログラミングについてよりよく理解できるように、次のアプリケーショ
ン ノートを参照してください。 

• AN73854 – PSoC™ 3, PSoC™ 4, and PSoC™ 5LP Introduction to Bootloaders 
• AN60317 – PSoC™ 3 and PSoC™ 5LP I2C Bootloader  
• AN68272 – PSoC™ 3, PSoC™ 4, and PSoC™ 5LP UART Bootloader 
• AN84858  – PSoC™ 4 Programming Using an External Microcontroller (HSSP) 
• AN61290  – PSoC™ 3 and PSoC™ 5LP Hardware Design Considerations 
• AN79953 – Getting Started with PSoC™ 4 

PSoC™ 4の他の多くの特長と機能に関わるアプリケーション ノート全ての一覧は、ここをクリックして
ください。 

http://www.cypress.com/?rID=56014&source=an86526
http://www.cypress.com/?rID=41002&source=an86526
http://www.cypress.com/?rID=50230&source=an86526
http://www.cypress.com/?rID=81013&source=an86526
http://www.cypress.com/?rID=43337&source=an86526
http://www.cypress.com/?rID=78695&source=an86526
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=76&id=4749&applicationID=0&l=0
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6 関連のプロジェクト 
このアプリケーション ノートに添付されたプロジェクトは、Table 5の通りにまとめられています。 

Table 5 本アプリケーション ノートに添付されているプロジェクト 

設計プロジェクト名 説明 
I2C_Bootloader_Red このプロジェクトは PSoC™用の I2Cブートローダ プロジェクトを PSoC™ 

Creatorを使用して作成する方法について説明する。このブートローダは
CY8CKIT-042*キットの赤色 LEDを点滅させる 

Bootloadable_Green このプロジェクトは PSoC™用のブートローダブル プロジェクトを PSoC™ 
Creatorを使用して作成する方法について説明する。このアプリケーションで
は CY8CKIT-042*キットの緑色 LEDを点滅させる 

Bootloadable_Blue このプロジェクトはブートローダブル プロジェクトの作成方法、およびブー
トローダブル プロジェクトからブートローダに入る方法について説明する。
このアプリケーションでは CY8CKIT-042*キットの青色 LEDを点滅させる 

I2C_Bootloader_Host これはブートローダ ホスト プログラム用例。この用例は PSoC™が別の PSoC™
をブートロードすることを説明する 

* プロジェクトは、簡単に別のキットで動作するように適合させることができます。 
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7 PSoC™リソース 
サイプレスは、www.cypress.comに大量のデータを掲載しており、ユーザーがデザインに適切な
PSoC™デバイスを選択し、デバイスをデザインに迅速で効果的に統合する手助けをしています。リソー
スの包括的なリストについては、「KBA86521, How to Design with PSoC™ 3, PSoC™ 4, and PSoC™ 5LP」
を参照ください。以下は PSoC™ 4のリソースの要約です。 

• 概要: PSoC™ポートフォリオ、PSoC™ロードマップ 
• 製品セレクタ: PSoC™ 1、PSoC™ 3、PSoC™ 4、または PSoC™ 5LP。さらに、PSoC™ Creatorにはデバ
イス選択ツールを含んでいます。 

• データシートでは、PSoC™ 4000、PSoC™ 4000S、PSoC™ 4100、PSoC™ 4100S、PSoC™ 4100PS、
PSoC™ 4100S Plus、PSoC™ 4200、PSoC™ 4xx7 BLE、PSoC™ 4200-M、および PSoC™ 4200-L デバイス 
ファミリ用の電気的仕様をご提供し、説明いたします。 

• CapSenseデザイン ガイド: PSoC™ 4ファミリのデバイスを使用して静電容量タッチセンス アプリケ
ーションを設計する方法について説明します。 

• アプリケーション ノートおよびサンプルコードは基本的なレベルから高度なレベルまでの幅広いト
ピックに触れています。アプリケーション ノートの多くはサンプルコードを含んでいます。PSoC™ 
Creatorはより多くのサンプルコードをご提供します。詳細については「サンプルコード」を参照く
ださい。 

• テクニカル リファレンス マニュアル (TRM): 各 PSoC™ 4デバイス ファミリのアーキテクチャとレジ
スタの詳細な説明をします。 

• 開発キット: 
− CY8CKIT-040、CY8CKIT-041、CY8CKIT-042、CY8CKIT-042-BLE、CY8CKIT-044、および CY8CKIT-046 

Pioneer Kitは使いやすく、安価な開発プラットフォームです。これらのキットには、Arduino™準拠
シールドおよび Digilent® Pmod™ドーターカード用コネクタを搭載しています。 

− CY8CKIT-001は、すべての PSoC™ファミリ デバイスの共通開発プラットフォームです。 
− CY8CKIT-147と CY8CKIT-149は、PSoC™ 4デバイスをサンプリングするための低コスト プロトタ
イプ プラットフォームです。 

• MiniProg3デバイスはフラッシュのプログラムとデバッグ用のインターフェースを提供します。 

7.1 PSoC™ Creator 
PSoC™ Creatorは Windowsベースの統合設計環境 (IDE) です。無料で利用できます。このキットによ
り、PSoC™ 3、PSoC™ 4および PSoC™ 5LPベースのシステムについて、ハードウェアとファームウェア
の同時並行の設計が可能です (Figure 35を参照ください)。PSoC™ Creatorにより、以下のことが可能で
す。 

1. コンポーネントをドラッグ アンド ドロップして、メインデザイン ワークスペースでハードウェア シ
ステム デザインを構築 

2. PSoC™ハードウェアとアプリケーション ファームウェアを同時設計 
3. コンフィギュレーション ツールを用いて、コンポーネントを構成 
4. 100以上のコンポーネントを含むライブラリを利用 
5. コンポーネント データシートの閲覧 

http://www.cypress.com/
http://www.cypress.com/?id=4&rID=77024&source=an79953
http://www.cypress.com/psoc
http://www.cypress.com/?rID=86788&source=an79953
http://www.cypress.com/?id=1573&source=an79953
http://www.cypress.com/?id=5041&source=an79953
http://www.cypress.com/?id=4976&source=an79953
http://www.cypress.com/?id=5044&source=an79953
http://www.cypress.com/?rID=94034&source=an79953
http://www.cypress.com/psoc4000sdatasheet
http://www.cypress.com/?rID=78805&source=an79953
http://www.cypress.com/psoc4100sdatasheet
http://www.cypress.com/psoc4100psdatasheet
http://www.cypress.com/documentation/datasheets/psoc-4-psoc-4100s-plus-datasheet-programmable-system-chip-psoc
http://www.cypress.com/?rID=78632&source=an79953
http://www.cypress.com/?rID=99492
http://www.cypress.com/?rID=108039
http://www.cypress.com/documentation/datasheets/psoc-4-psoc-4200l-family-datasheet
http://www.cypress.com/?rID=78578&source=an79953
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=76&id=4749
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=117&id=4749&applicationID=0&l=0
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=110&id=4749&applicationID=0&l=0
http://www.cypress.com/?rID=94456&source=an79953
http://www.cypress.com/CY8CKIT-041
http://www.cypress.com/go/cy8ckit-042
http://www.cypress.com/go/cy8ckit-042-ble
http://www.cypress.com/cy8ckit-044
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-046-psoc-4-l-series-pioneer-kit
http://www.cypress.com/go/cy8ckit-001
http://www.cypress.com/CY8CKIT-147
http://www.cypress.com/CY8CKIT-149
http://www.cypress.com/go/cy8ckit-002
http://www.cypress.com/psoccreator/?source=an79953
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Figure 35 PSoC™ Creatorの特長 

7.2 サンプルコード 
PSoC™ Creatorには多数のサンプルコードのプロジェクトが含まれています。これらのプロジェクトは
Figure 36に示すように、PSoC™ Creatorのスタート ページからアクセスできます。 

用例のプロジェクトにより、空のページではなく出来上がった設計を元に始めるため、設計時間を短縮
することができます。用例のプロジェクトは PSoC™ Creatorコンポーネントを様々なアプリケーション
に使用する方法も示します。Figure 36に示すように、サンプルコードおよびデータシートが含まれてい
ます。 

Figure 37に示す「Find Example Project」ダイアログには、いくつかのオプションがあります。 

• アーキテクチャまたはデバイス ファミリ (PSoC™ 3、PSoC™ 4、PSoC™ 5LP) またはカテゴリやキーワー
ドに基づいて用例のプロジェクトをフィルターします。 

• Filter Optionsに基づいて提供された用例のプロジェクトのメニューから選択します。 
• 選択のためにデータシートをレビューします (Documentationタブ上で) 。 
• 選択のためにサンプルコードをレビューします。コード開発時間を短縮させるために、このウィン
ドウからコードをコピーしプロジェクトに貼り付けることができます。 

• 選択したものをベースに新規プロジェクト (また必要な場合は新規ワークスペース) を作成します。
完成した基本的な設計から始めることで設計時間を短縮させます。そのあと設計をアプリケーショ
ンに適合させることができます。 
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Figure 36 PSoC™ Creatorのサンプルコード 

 

 

Figure 37 サンプルコードを含む用例のプロジェクト 



  

Application Note 35 of 56 001-89532 Rev. *E  
  2021-10-25 

PSoC™ 4 I2Cブートローダ 
  
PSoC™リソース 

  

7.3 PSoC™ Creatorヘルプ 
PSoC™ Creatorホームページへアクセスし、PSoC™ Creatorの最新版をダウンロードしてください。次
に、PSoC™ Creatorを起動して以下のアイテムへナビゲートします。 

• クイック スタート ガイド: Help > Documentation > Quick Start Guideを選択します。このガイドは
PSoC™ Creatorプロジェクトを開発するための基礎知識を提供します。 

• 簡単なコンポーネント用例のプロジェクト: File > Open > Example projectsを選択します。これらの
用例プロジェクトは、PSoC™ Creatorのコンポーネントの設定と使用方法を説明します。 

• Starter designs (初級者向けの設計): File > New > Project > PSoC 4 Starter Designsを選択します。こ
れらの初級者向けの設計は、PSoC™ 4のユニークな機能を説明します。 

• システム リファレンス ガイド: Help > System Reference > System Reference Guideを選択します。こ
のガイドは PSoC™ Creatorにより提供されるシステム機能を一覧で説明します。 

• コンポーネント データシート: コンポーネントを右クリックして「データシートを開く」を選択し
ます。全ての PSoC™ 4のコンポーネント データシートの一覧を表示するには、PSoC™ 4のコンポー
ネント データシートページへアクセスしてください。 

• ドキュメント マネージャー: PSoC™ Creatorが提供するドキュメント マネージャーにより、ドキュメ
ント リソースを容易に検索し、閲覧することができます。ドキュメント マネージャーを開くには、
メニューアイテムの Help > Document Managerを選択します。 

7.4 テクニカル サポート 
ご質問には弊社のテクニカル サポート チームが対応させて頂きますので、お気軽にご連絡ください。
Cypress Technical Supportページにアクセスし、サポート リクエストを作成してください。 

米国のお客様は、テクニカル サポート チームに連絡する際、以下の電話番号 (通話無料) にお問い合わ
せください: +1-800-541-4736 プロンプトでオプション「8」を選択してください。 

緊急サポートが必要な場合は、以下のサポート リソースをご利用ください。 

• セルフ ヘルプ 
• 所在地の販売代理店 

 

http://www.cypress.com/?id=2494&source=an79953
http://www.cypress.com/?id=4749&rtID=377
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=377&id=4749&source=an79953
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=377&id=4749&source=an79953
https://secure.cypress.com/myaccount/?id=25&techSupport=1&source=an79953
http://www.cypress.com/support
http://www.cypress.com/?id=1062
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8 付録 A: メモリ  

8.1 フラッシュメモリの詳細 
フラッシュ メモリはファームウェア、バルク データ、デバイスの設定データ、工場出荷時の設定デー
タおよびユーザー定義のフラッシュ プロテクション データの記憶領域を提供します。Figure 38は
PSoC™にあるフラッシュ メモリの物理的な構造を示します。 

PSoC™のフラッシュ メモリは「アレイ」と呼ばれるブロックに分けられます。アレイはアレイ IDによ
って個別に識別されます。それぞれのアレイには、フラッシュ メモリの 128個または 256個の列があり
ます。各行には、PSoC™ 4100、4200、4000Sと 4100PS ファミリ デバイス用の 128データ バイト、4100S
ファミリ デバイス用の 256データ バイトおよび 4000ファミリ デバイス用の 64データ バイトがありま
す。 これにより、アレイは命令とデータの記憶領域用に 8KB、16KB 、32KBまたは 64KBを持つことが
できます。 

PSoC™ 4100、4200、4000Sと 4100PSデバイス ファミリは、最大フラッシュ 32KBを備え、これは 1つだ
けのアレイであり、唯一の有効なアレイ IDは 0です。PSoC™ 4100Sデバイスは、最大フラッシュ 64KB
を備え、これも 1つだけのアレイであり、唯一の有効なアレイ IDは 0です。また PSoC™ 4000デバイス
は最大フラッシュ 16KBを備え、これも 1つだけのアレイで、唯一有効なアレイ IDも 0です。 

フラッシュ メモリは 1回で 1列がプログラムされます。1回で 1列が消去でき、また同時にフラッシュ 
メモリ全体を消去できます。列はアレイ IDと列番号のユニークな組み合わせで識別されます。 

Figure 38は、フラッシュ メモリの最初の X列はブートローダで占められていることも示します。Xは、
以下の項目に十分な空間があるように設定されます。 

• アドレス 0から始まるブートローダのベクタ テーブル 
• ブートローダ プロジェクトの設定バイト 
• ブートローダ プロジェクトのコードとデータ 
• フラッシュのブートローダ部のチェックサム 

PSoC™の場合、ベクタ テーブルは、ブートローダ プロジェクトの初期スタック ポインタ (SP) 値、およ
びブートローダ プロジェクト コード用の開始アドレスを含みます。また、ブートローダが使用する、
例外および割り込み用のベクタも含みます。 

ブートローダブル プロジェクトは、ブートローダの次にある最初の 128バイト境界から始まるフラッシ
ュ領域を占有しています。このフラッシュ メモリ領域は以下の項目を含みます。 

• ブートローダブル プロジェクトのベクタ テーブル 
• ブートローダブル プロジェクトのコードとデータ 

フラッシュ メモリの最上位の 64バイト ブロックは、2つのプロジェクトの共有記憶領域として使用さ
れます。このブロックに保存されるパラメーターは以下の通りです。 

• ブートローダブル プロジェクトのフラッシュ メモリ内のエントリ アドレス (4バイトのアドレス) 
• ブートローダブル プロジェクトが占有するフラッシュ メモリ量 (フラッシュの列数) 
• フラッシュ メモリのブートローダブル ブロックのチェックサム (1バイト) 
• フラッシュ メモリのブートローダブル ブロックのバイト単位のサイズ (4 バイト)。 

フラッシュ メモリ内のメタデータの場所にある詳細情報は、フラッシュ メモリ内のメタデータ レイア
ウトを参照してください。 



  

Application Note 37 of 56 001-89532 Rev. *E  
  2021-10-25 

PSoC™ 4 I2Cブートローダ 
  
付録 A: メモリ 

  

 

Byte 0 Byte 1 Byte L• • • • • • • 

Row 1

Row 2

Row 3

Row 4

Row 5

Row 6

Row 7

Row 8

•
•
•
•
•

Row N

Array 0

= 128-1 or 64-1, depending on the part
= 128-1 or 256-1, depending on part

= Bootloader Portion
= Bootloadable Portion
= Reserved for Metadata

L
N

 

Figure 38 PSoC™内のフラッシュ メモリの物理的な構造 

8.2 PSoC™のメモリ使用量 
ブートローダ プロジェクトは 2種類あります。それは標準ブートローダとマルチアプリケーション ブ
ートローダです。マルチアプリケーション ブートローダは、実行可能な有効なアプリケーションが常に
存在する保証が必要な設計に役立ちます。しかし、この保証には、各アプリケーションのフラッシュ メ
モリ領域を半分しか使用できない制限があります。 

Figure 39は PSoC™ Creatorプロジェクトの各種類に対するフラッシュ メモリ使用量を示します。 
 

Normal 
Application Bootloader 

Application

Bootloadable 
Application

Metadata

Multi- Application 
Bootloader

Bootloadable 
Application

# 1

Metadata # 1
Metadata # 2

Bootloadable 
Application

# 2
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Figure 39 フラッシュ メモリの使用量 
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8.3 フラッシュ メモリ内のメタデータの配置 
Figure 39に示すように、メタデータの部分は、ブートローダとブートローダブル プロジェクトの共有
記憶領域として使用されるフラッシュ メモリ内の最上位 64バイトのブロックです。Table 6に示すよう
に、様々なパラメーターがこのブロックに格納されます。マルチアプリケーション ブートローダには 2
セットのメタデータがあります。 

Table 6 メタデータの配置 

アドレス PSoC™ 
0x00 アプリケーション チェックサム 
0x01 アプリケーション アドレス 
0x02 
0x03 
0x04 
0x05 最後のブートローダ列 
0x06 
0x07 
0x08 
0x09 アプリケーションの長さ 
0x0A 
0x0B 
0x0C 
0x0D 該当なし 
0x0E 該当なし 
0x0F 該当なし 
0x10 アプリケーション アクティブ 
0x11 アプリケーション ベリファイ 
0x12 ブートローダ アプリケーションのバージョン 
0x13 
0x14 ブートローダブル アプリケーションの ID 
0x15 
0x16 ブートローダブル アプリケーションのバージョン 
0x17 
0x18 ブートローダブル アプリケーションのカスタム ID 
0x19 
0x1A 
0x1B 
0x1C-0x3F 該当なし 

Note: マルチアプリケーション ブートローダでは、メタデータ用の最後のブートローダ列 (イメ
ージ 2) はブートローダ列ではなく、フラッシュ メモリにあるブートローダブル 1の最後
の列を示します。 
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8.3.1 フラッシュ メモリの保護 
ブートローダ コードが無効になると、製品が使用できなくなります。そのため、フラッシュ メモリの
ブートローダを不慮の上書きから保護する必要があります。 

PSoC™の保護はチップレベルの保護 (オープン、プロテクテッド、キル) およびフラッシュ レベルの保護
があります。詳細については、デバイスのデータシートまたはテクニカル リファレンス マニュアル 
(TRM) を参照してください。フラッシュ メモリ保護の機能は、ユーザー独自のコードの複製やリバース 
エンジニアリングを防止するように設計されています。しかし、これはフラッシュ メモリのブートロー
ダ部への予期しない書き込みから守るためにも使用されます。 

Table 7に示すように、フラッシュ レベル保護は 2つのレベルに分けられます。フラッシュ メモリの各
列は PSoC™ Creator (.cydwrファイルのフラッシュ セキュリティ タブ) を使用してセットすることで、そ
れぞれ異なる保護レベルを持つように設定できます。 

Table 7 PSoC™のフラッシュ メモリ保護レベル 

保護レベル 許可 不可 
非保護 外部読み出しおよび書き込み 

内部読み出しおよび書き込み 
– 

完全保護 内部読み出し 
外部読み出し 

外部書き込み 
内部書き込み 

フラッシュ メモリのブートローダ部が「完全保護」の保護レベルに設定されると、その設定を変更でき
ません。保護レベルまたはブートローダ コードを変更する方法は、フラッシュ メモリを全て消去し
て、SWDインターフェースを使って再プログラムすることのみです。 

以下はブートローダのフラッシュ メモリ保護の例です。 

8.3.2 フラッシュ メモリ保護の例 
ブートローダ プロジェクトが構築されると、PSoC™ Creator出力ウィンドウは使用したフラッシュ メモ
リ量を示します。例えば、I2C_Bootloaderプロジェクトが占めるフラッシュ メモリが 4352バイトの場
合、 (32KBフラッシュの PSoC™の場合) 出力は以下の通りです。 

Flash used: 4352 of 32768 bytes (13.3%). 

この例では、ブートローダはフラッシュ メモリの 34列 (4352 ／128) を占めます。すなわち、フラッシュ 
メモリ内の場所は、0x0000 ～ 0x10FF です。(PSoC™ Creatorにある.cydwr ファイルのフラッシュ セキュリ
ティ タブを通して) これらの列のフラッシュ メモリ保護レベルを「完全保護」に設定します。残りの列
の保護レベルは Figure 40に示すように非保護 (デフォルト) にできます。フラッシュ メモリ保護ダイア
ログの使用方法の詳細については、PSoC™ Creator のヘルプ記事「Flash Security Editor」を参照してくだ
さい。 
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Figure 40 PSoC™ Creator内のフラッシュ メモリ保護 
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9 付録 B: プロジェクト ファイル 

9.1 ブートローダブルの出力ファイル 
PSoC™ Creatorプロジェクトが構築されると、.hexタイプの出力ファイルが生成されます。このファイル
は、SWDインターフェースを使ったプログラミング時に PSoC™へダウンロードされるファイルです。 

ブートローダブル プロジェクトの場合、.hexファイルはブートローダブル プロジェクトと関連するブー
トローダ プロジェクトが結合された.hexファイルです。通常は、プロダクション環境でこのファイルを
使用して、両方のプロジェクトを SWD経由でダウンロードします。 

9.1.1 *.cyacdのファイル フォーマット 
ブートローダブル プロジェクトが構築されると、.cyacdタイプ (アプリケーション コードとデータ) の追
加ファイルも生成されます。このファイルには、ヘッダがあり、その後にフラッシュ メモリのデータ行
が続きます。ヘッダを除くと、.cyacdファイルの各行は、それぞれフラッシュ メモリのデータの 1列分
を示します。データは、ビッグエンディアン形式の ASCIIデータとして保存されます。従って、ブート
ロードの時、このファイルの内容は構文解析する (ASCII から hex に変換される) 必要があります。構文解
析は.hexタイプのファイルをプログラムする時には必要ありません。 

このファイルのヘッダは次のフォーマットになっています。 

[4 bytes Silicon ID] [1 byte Silicon rev] [1 byte checksum type] 

フラッシュ メモリの列は次のフォーマットになっています。 

[1 byte array ID] [2 bytes row number] [2 bytes data length] [N bytes of 
data] [1 byte checksum] 

ヘッダ内のチェックサムタイプは、ブートロード処理中にブートローダのホストとブートローダとの間
で送信するパケット用に使用するチェックサムのタイプを示します。このバイトが 0の場合、チェック
サムは単純な合計値です。このバイトが 1の場合、チェックサムは CRC-16です。 
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10 付録 C: ホスト／ターゲットの通信 

10.1 通信フロー 
ブートローダ ファンクション フローの節では、PSoC™内のブートローダ動作を説明し、I2Cブートロ
ーダのホストの節では、ブートローダ ホストの構成ブロックを紹介しています。これに基づいて、
Figure 41はブートローディング中のホストとターゲット間の通信フローについて説明します。これは、
コマンドがターゲットに発行され、応答が受信される順序を示します。ブートロード コマンドの完全な
リスト、そのコードと期待される応答については、コマンドとステータス／エラーコードを参照して
ください。 
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checksum against the checksum stored 

in the flash
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project

Issue program row command along with 
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Send verify checksum 
command to verify the 
entire application code 

checksum

Issue ‘End Bootload 
operation’ command

Enter Bootload Command Gets the Silicon ID, Silicon Rev 
and bootloader version. Put this in 

the response packetCheck whether the Silicon ID and Silicon 
Rev received are same as those contained 

in the bootloadable file. 
Send the ‘Get Flash Size’ command. Send the start and end row 

numbers of the bootloadable flash 
area. With these start and end row numbers, make 

sure whether the rows to be programmed are 
within the bootloadable area of the flash.

Then, split the row data into small chunks and 
send them with the ‘Send Data’ command

Erase the specified flash row and 
program it with the new row data.

Send ‘Verify Row’ command to 
verify the programmed row data.

Verify whether the received 
checksum matches with the 

expected row checksum.

Silicon ID, Silicon Rev, Bootloader ver

Get Flash Size Command

Start and End row numbers

Send Data Command

Success / Failure

Program Row Command

Success / Failure

Verify Row Command

Row Checksum

Verify Application Checksum

Checksum Good / Bad

End Bootload Command

NACK

 

Figure 41 ブートローディング中の通信フロー 
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10.2 プロトコル パケットのフォーマット 
ブートロード動作はホストとターゲット間のコマンドと応答パケットの交換を含みます。これらのパケ
ットは Figure 42に示すように、特定のフォーマットを持っています。 
 

                  N bytes of dataStart
 0x01

Data length (N)Command 
code

1 byte 1 byte 2 bytes N bytes 2 bytes 1 byte

Command packets from the host

End
0x17

Checksum

                  N bytes of dataStart
 0x01

Status / 
Error code

1 byte 1 byte 2 bytes N bytes 2 bytes 1 byte

Response packets from the target

End
0x17

LSB MSB LSB MSB

Data length (N)

LSB MSB

Checksum

LSB MSB

Compute checksum for these bytes

Compute checksum for these bytes

 

Figure 42 ブートロードパケットのフォーマット 

それぞれのパケットはチェックサムバイトを含みます。チェックサムは、ブートローダ プロジェクトの
設定によって、単純合計 (2の補数) または CRC-16のいずれかにできます。データ長とチェックサムなど
のマルチバイト データを送信する時、最下位バイトが先に送信されます。 

ブートローダは応答パケットでホストからのコマンドに応答します。応答パケットのフォーマットは、
コマンド コードの代わりにステータス／エラーコードがあることを除いて、コマンド パケットのフォ
ーマットと似ています。重要なコマンドとデータバイトおよびブートローダ応答パケット データは 44
ページの Table 8に示されています。 

10.3 ブートローダ ホスト用の I2Cトランザクション情報 
I2C トランザクションは、2つのデバイス間通信のより低い階層です。ホストから PSoC™の読み出しと書
き込みフォーマットは、Figure 43と Figure 44に表示されます。 
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slave 
address ackstart ack

data 
length 2
(MSB)

data 
length 1
(LSB)

ackcommandack
packet 
start

(0x01)
ackr/w

(0)

ack
end 

packet
(0x17)

payload 
data 1 stopackack

checksum 
2

(MSB)
ack

checksum 
1

(LSB)
ackpayload 

data N...

1 bit 7 bit 1 bit 1 bit 1 byte 1 bit 1 byte 1 bit 1 byte 1 bit 1 bit

1 byte 1 bit 1 byte 1 bit 1 byte 1 bit 1 byte 1 bit 1 byte 1 bit 1 bit

communication from host to bootloader communication from bootloader to host
 

Figure 43 I2Cインターフェースを介してホストからブートローダに送信されるトランザクション (書

き込み)  

 

slave 
address ackstart ack

data 
length 2
(MSB)

data 
length 1
(LSB)

ackstatus/ 
errorack

packet 
start

(0x01)
ackr/w

(1)

ack
end 

packet
(0x17)

payload 
data 1 stopnackack

checksum 
2

(MSB)
ack

checksum 
1

(LSB)
ackpayload 

data N...

1 bit 7 bit 1 bit 1 bit 1 byte 1 bit 1 byte 1 bit 1 byte 1 bit 1 bit

1 byte 1 bit 1 byte 1 bit 1 byte 1 bit 1 byte 1 bit 1 byte 1 bit 1 bit

communication from host to bootloader communication from bootloader to host
 

Figure 44 I2Cインターフェースを介してブートローダから受信されるトランザクション (読み出し)  

10.3.1 コマンドとステータス／エラーコード 
前の節で説明した通り、コマンドと応答パケットの構造は同じです。唯一の違いは、第 2バイトがコマ
ンド コードかステータス／エラー コードを含むかどうかです。 

Table 8は、コマンドのリストとその期待される応答の一覧です。46ページの Table 9はステータスとエ
ラーコードの一覧です。 

Table 8 ブートローディング コマンド 

コマンド 
バイト 

コマンド コマンド パケット内の
データ バイト 

期待する応答データ バイト 

0x31 Verify 
Checksum 
(チェックサ
ムの検証) 

該当なし 1バイト: 「0」またはゼロ以外 
ゼロ以外のバイトの場合、アプリケーション チ
ェックサムが一致し、それは有効なアプリケー
ション 
ゼロのバイトの場合、チェックサムが間違い、
アプリケーションは無効 
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コマンド 
バイト 

コマンド コマンド パケット内の
データ バイト 

期待する応答データ バイト 

0x32 Get Flash 
Size  
(フラッシュ 
メモリ サイ
ズの取得) 

フラッシュ アレイ ID、
1バイト 

ブートローダブル フラッシュ領域の最初の列番
号、2バイト 
ブートローダブル フラッシュ領域の最終の列番
号、2バイト 
これらの番号は要求されたアレイ ID用のもので
ある 

0x33 アプリケー
ションステ
ータスを取
得 (マルチア
プリケーシ
ョン ブート
ローダのみ
に有効) 

アプリケーションの番
号、1バイト 

有効なアプリケーションの番号、1バイト 
アクティブ アプリケーションの番号、1バイト 
指定されたアプリケーションが有効でアクティ
ブかどうかチェック 

0x34 Erase Row  
(列の削除) 

フラッシュ アレイ ID、
1バイト 
フラッシュ メモリ列の
番号、2バイト 

適用なし 
指定されたフラッシュ メモリ列の内容を消去 

0x35 Sync 
bootloader  
(ブートロー
ダの同期) 

該当なし 該当なし 
ブートローダをクリーンな状態にリセットしま
す。バッファ内のデータは全て廃棄される。こ
のコマンドは、ブートローダとホストが互いに
同期しなくなる場合にのみ必要である 

0x36 Set Active 
Application 
(アクティブ 
アプリケー
ションを設
定) (マルチ 
アプリケー
ション ブー
トローダに
のみ有効)  

アプリケーションの番
号、1バイト 

該当なし 
指定されたアプリケーションをアクティブとし
て設定 

0x37 Send Data  
(データの送
信) 

送信される Nデータバ
イト 

該当なし 
受信されたデータ バイトは、プログラム列コマ
ンドを見越してブートローダによってバッファ
される 

0x38 Enter 
Bootloader 
 (ブートロー
ダに入る) 

該当なし シリコン ID、4バイト 
シリコン リビジョン、1バイト 
ブートローダ バージョン、3バイト 
全てのコマンドは、このコマンドを受信するま
で無視される 
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コマンド 
バイト 

コマンド コマンド パケット内の
データ バイト 

期待する応答データ バイト 

0x39 Program 
Row  
(列をプログ
ラム) 

フラッシュ アレイ ID、
1バイト 
フラッシュ メモリ列の
番号、2バイト 
送信される Nデータ バ
イト 

該当なし 
複数のデータバイトをデータ送信コマンドでブ
ートローダに送信した後、データの最終チャン
クはこのコマンドと共に送信される  

0x3A Verify Row  
(列の検証 ) 

フラッシュアレイ ID、1
バイト 
フラッシュ メモリ列の
番号、2バイト 

列のチェックサム、1バイト 
指定された列のチェックサムを返す 

0x3B Exit 
Bootloader  
(ブートロー
ダの終了) 

該当なし 該当なし 
このコマンドは認識されない 

Table 9 ブートローディング ステータス／エラーコード – コマンドへの可能な応答 

ステータス／
エラーコード 

ラベル 説明 

0x00 CYRET_SUCCESS コマンドは正しく受信され、実行された 
0x02 BOOTLOADER_ERR_VERIFY フラッシュのベリファイに失敗した 

0x03 BOOTLOADER_ERR_LENGTH 利用可能なデータ量は予想される範囲外 

0x04 BOOTLOADER_ERR_DATA データが正しい形式ではない 

0x05 BOOTLOADER_ERR_CMD コマンドを認識しなかった 

0x06 BOOTLOADER_ERR_DEVICE 期待されるデバイスと検出したデバイスが一致
しない 

0x07 BOOTLOADER_ERR_VERSION 検出したブートローダのバージョンに対応して
いない 

0x08 BOOTLOADER_ERR_CHECKSUM チェックサムが想定した値と異なる 

0x09 BOOTLOADER_ERR_ARRAY フラッシュ アレイ IDが有効でない 

0x0A BOOTLOADER_ERR_ROW フラッシュ行の数は有効でない 

0x0C BOOTLOADER_ERR_APP アプリケーションは有効ではなく、アクティブ
に設定できない  

0x0D BOOTLOADER_ERR_ACTIVE アプリケーションは現在アクティブとしてマー
クされていない 

0x0F BOOTLOADER_ERR_UNK 未知のエラーが発生した 
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11 付録 D: ホストコア API 

11.1 cybtldr_api2.c / .h 
これは、ブートロード動作の全てを処理する、より高レベルの APIです。ファイルを開く関数とファイ
ルを閉じる関数があります。これはブートロード動作のために、cybtldr_api.c / .hAPIの関数を呼び出し
ます。この APIは GUIベースのブートローダ ホストを構築する時に使用されます。 

11.2 cybtldr_parse.c / .h 
このモジュールは、デバイスに送信するブートローダブルのイメージを含む.cyacdファイルの構文解析
を行います。ファイルへのアクセス設定、ヘッダの読み出し、列のデータの読み出し、およびファイル
を閉じるための関数も持っています。 

11.3 cybtldr_api.c / .h 
これは 1回に 1つのデータ列をブートローダのターゲットに送信する列レベル APIファイルです。ブー
トロード動作の設定、行の消去、行のプログラミング、行の検証、およびブートロード動作の終了を行
う関数が含まれています。Table 10は、この APIファイルの関数の詳細を説明します。 

Table 10 cybtldr_api.c /.hの関数 

関数 説明 
CyBtldr_StartBootloadOperation 通信インターフェースを有効にし、Enter Bootloaderコマンド

をターゲットに送信する。 
受信された応答パケットから、ターゲット デバイスのシリコ
ン ID、シリコン リビジョンおよびブートローダのバージョン
を確認する 

CyBtldr_ProgramRow 最初に列を確認する。つまり、ターゲット フラッシュの特定
のアレイ IDのために、Get Flash Sizeコマンドをターゲットに
送信する。これに対する応答で、ターゲットはそのアレイに
あるブートロード可能なフラッシュ部の開始と終了の列番号
を返す。ホストはこの応答を読み込んで、指定した列がフラ
ッシュのブートローダブルの領域にあるかどうか確認する。 
列の確認が成功したら、ホストは列データをより細かい部分
に分割して、Send Dataコマンドでターゲットに送信する。 
列データの最終部と共に、Program Rowコマンドをターゲット
に送信する 

CyBtldr_VerifyRow この関数は最初に特定のアレイ IDと列番号のために列を確認
する。 
列の確認が成功したら、確認されたフラッシュ列の Verify Row
コマンドを送信する。このコマンドの応答で、ターゲットは
列のチェックサムを返す。 
返されたチェックサムは期待されるチェックサム値と比較さ
れる 

CyBtldr_EraseRow この関数も最初に特定のアレイ IDと列番号のために列を確認
する。 
列の確認が成功したら、確認されたフラッシュ列の Erase Row
コマンドを送信する 
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関数 説明 
CyBtldr_EndBootloadOperation Exit Bootloadコマンドを送信し、通信インターフェースを無効

化する 
 

11.4 cybtldr_command.c / .h 
この APIは、ターゲットへのコマンド パケットの構成を処理し、ターゲットから受信した応答パケット
を解析します。cybtldr_api.c / .h は、この APIの関数を呼び出します。例えば、Enter Bootloadコマンド
を送信するために、CyBtldr_StartBootloadOperation()は、この APIの 
CyBtldr_CreateEnterBootloadCmd()関数を呼び出します。また、ターゲットに送信する前に、コマ
ンド パケットのチェックサムを計算する関数もあります。 
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12 付録 E: その他のトピック 

12.1 HSSP対ブートローダ 
ブートローダは、通信インターフェースを経由してシステム ファームウェアをアップグレードできるよ
うにします。しかし、ブートローダのフラッシュ領域を含む完全なフラッシュのアップグレードを完了
させるためには、SWDプログラマ (Host Sourced Serial Programming) を使用する必要があります。PSoC™ 
4の HSSPを作成するには、「AN84858, PSoC™ 4 Programming Using an External Microcontroller 
(HSSP)」を参照してください。 

12.2 ブートロード処理中に電源が切れた場合は、どのようになるのか？ 
ブートロード処理中に電源が切れたら、次のリセットで、ブートローダブル プロジェクトのチェックサ
ムが期待の値 (フラッシュの最終列に格納されるブートローダブル プロジェクトのチェックサム) と一致
せず、そのブートローダブル プロジェクトが無効であると見なされます。ブートロードが成功するまで
プログラムの実行はブートローダ内に留まります。ブートローダホストは、ブートロード動作を再起動
するようにブートロード開始のコマンドを送信する必要があります。 

12.3 なぜブートローダとブートローダブル プロジェクト間にジャンプする
ためにリセットが必要か？ 

PSoC™は非常にコンフィギュアラブルなデバイスです。ブートローダはファームウェアと内蔵ハードウ
ェア リソースの変更を許可します。その高度なコンフィギュアラブルなアーキテクチャにより、ハード
ウェアの再設定 (配置、配線、ファンクション) はリセット状態にのみ可能です。従って、ブートローダ
はブートローダとブートローダブル プロジェクト間にジャンプするリセットが必要になります。 

12.4 通常アプリケーション プロジェクトのブートローダブル プロジェク
トへの変換 

標準 (通常) のアプリケーション プロジェクトを既に作成し、これをブートローダブル プロジェクトに
変換したい場合は、13ページの Figure 11に示すようにトップ デザインにブートローダブル コンポーネ
ントを追加し、ブートローダ プロジェクトの.hexファイルを依存関係として追加してください。 

プロジェクトが通常のプロジェクトとして作成された後で、アプリケーション タイプを「Bootloader」
に変更することでブートローダ プロジェクトに変更させる場合、ブートローダ プロジェクトが期待す
るように実行されるために、Bootloader_Start()呼び出し関数を main.cに挿入してください。 

Note: PSoC™ Creator 3.1の場合、標準 (通常) のプロジェクトをブートローダブル／ブートローダ 
プロジェクトに変換したい時に、プロジェクトのアプリケーション タイプを
「Bootloadable/Bootloader」に変更してください。それを行うには、「Project」を右クリ
ックして、「Build Setting」>「Code Generation」>「General」タブを選択して、
「Application Type」を変更します。そして、トップ デザインにブートローダブル／ブー
トローダ コンポーネントを追加します。   

12.5 ブートローダブル プロジェクトのデバッグ 
PSoC™ Creatorブートローダ システムでは、最初にブートローダ プロジェクトが、そしてブートローダ
ブル プロジェクトが実行されます。ブートローダからブートローダブル プロジェクトへのジャンプは
ソフトウェアが制御するデバイスリセットによって実施されます。この時、デバッガ インターフェース
はリセットされます。つまり、ブートローダブル プロジェクトはデバッガ モードで実行できません。 

http://www.cypress.com/?rID=81013&source=an86526
http://www.cypress.com/?rID=81013&source=an86526
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ブートローダブル プロジェクトをデバッグするために、その「Application Type」を「Normal」に変更し
て、デバッグを実行します。デバッグが完了した後、それを「Bootloadable」に変えます。 

他のオプションは、ブートローダブル プロジェクトの.hexファイルをデバイスにプログラムすることで
す。そして、ブートローダブルプロジェクトが実行中に、「Attach to running target」オプションを使用
してデバッグを実行します。この場合には、デバッガがデバイスに取り付けられた時点からのみ、ブー
トローダブル プロジェクトのデバッグを実行できます。 

12.6 マルチアプリケーション ブートローダ 
マルチアプリケーション ブートローダ (MABL) は 2つのブートローダブルのアプリケーションを同時に
フラッシュに入れる時に使用されます。デバイスのフラッシュに 1つの有効なアプリケーションが常に
存在するよう、2つのアプリケーションを同じものにすることができます。または、ブートローダ コマ
ンドを使用して切り替えることができるように、2つのアプリケーションを異なるものにすることもで
きます。確かに、各アプリケーションがフラッシュ領域を半分しか使用できないことはこの機能の制限
です。 

Figure 39はフラッシュ メモリ内で MABL用のプロジェクト配置を示します。 

MABLは、標準ブートローダのアプリケーションとは異なる次の手順に従って実施できます。 

1. MABLブートローダ プロジェクトを新規作成します。ブートローダの設定ウィンドウで「Multi-App 
Bootloader」チェックボックスにチェックを入れます。  

Note: PSoC™ Creator 3.1の場合、アプリケーション タイプを「Multi-App Bootloader」に設定しま
す。 

2. 「Project_A」と「Project_B」という 2つのブートローダブル プロジェクトをワークスペースに追加
します。各プロジェクトでは、MABLプロジェクトに依存関係を追加します。各プロジェクトのため
に生成された 2つの.cyacdファイルは以下のように、1つのファイルはフラッシュの上位領域用のも
ので、残りはフラッシュの下位領域用のものです(Figure 39を参照してください)。 
− Project_A_1.cyacdと Project_A_2.cyacd 
− Project_B_1.cyacdと Project_B_2.cyacd 

3. 通常は、1のサフィックスを付ける.cyacdファイルは、フラッシュの前半分を、2のサフィックスを
付ける.cyacdファイルは、フラッシュの後半分を占めます。そのため、.cyacdファイルの特定の結合
のみが使用できます。これらの結合は以下の通りです。 
− Project_A_1.cyacdと Project_A_2.cyacd 
− Project_B_1.cyacdと Project_B_2.cyacd 
− Project_A_1.cyacdと Project_B_2.cyacd 
− Project_B_1.cyacdと Project_A_2.cyacd 

4. デバイスをマルチアプリケーション ブートローダ プロジェクトでプログラムし、上記のいずれか 1
つの結合に従い、ブートローダのホスト アプリケーションを使用して、アプリケーション (.cyacdフ
ァイル) を順番にブートロードします。 

5. アプリケーション間の切り替えは、下記の手順に従ってください。 
− USBケーブルを使って、PSoC™キットを PCに接続します。ブートローダがアクティブであること
を確認してください。 

− Start > All Programs > Cypress > Bridge Control Panelに移動して、Bridge Control Panelを開きま
す。I2Cプロトコルの KitProgを選択します。 

− 0x38コマンドを送信して、ブートローダに入ります。 

w 08 01 38 00 00 C7 FF 17  
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r 08 x x x x x x x x x x x x x x x 

− application_1から application_2 に切り替えるために、「set_active_application」コマンド (0x36) を
送信します。 

w 08 01 36 01 00 01 C7 FF 17 

r 08 x x x x x x x 

− application_2から application_1に切り替えるために、「set_active_application」コマンド (0x36) を
送信します。 

w 08 01 36 01 00 00 C8 FF 17 

r 08 x x x x x x x 

− 「exit_bootloader」コマンド (0x3B) を送信して、アプリケーションを実施します。 

w 08 01 3B 00 00 C4 FF 17 

r 08 x x x x x x x 

これらのコマンドは、Table 11に「set_active_application」コマンド (application_1から application_2
へ) の例を使って説明されています。  

Table 11 コマンド バイト 

バイト 1 1 1 2 N 2 1 
値 08 01 36 01 00 01 C7 FF 17 
説明 スレーブ 

アドレス 
パケット
開始バイ
ト 

コマンド 後続するバイト
数(LSBファース
ト) 

データ
バイト 

チェックサム
(LSBファースト) 

パケット
終了バイ
ト 

12.6.1 ブートローダ用に必要なメモリ量 
全てのオプション コマンドを含む標準 I2Cブートローダ プロジェクトは、Arm GCCコンパイラの最適化
を「size」に設定した場合、PSoC™フラッシュ メモリの約 4.3KBを占めます。プロジェクトを構築する
時、ブートローダ プロジェクトが使用するメモリを出力ウィンドウで見ることができます。ブートロー
ダ プロジェクトが使用する RAMメモリはブートローダブル プロジェクトによって再使用できます。 

Figure 45に示すように、ブートローダブル プロジェクトのメモリ使用量は、ブートローダ コンポーネ
ントがサポートするオプションのコマンドを取り除くことにより、少量に低減できます。 

Figure 46に示すように、.cydwr > Systemタブ内で Device Configuration Modeを Compressedに設定し
て、フラッシュ メモリの使用量を最小限に抑えます。  
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Figure 45 ブートローダ コンポーネント内のオプションのコマンドをチェックしない時 

 

 

Figure 46 デバイス設定モード 
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12.6.2 PSoC™キットと PSoC™用 MiniProg3の比較 
PSoC™ 4キットおよび MiniProg3は、PSoC™用にデバッグ／プログラムおよび USB-I2Cブリッジをサポー
トします。また、PSoC™は、MiniProg3 がまだ対応していない USB-UARTブリッジもサポートします。そ
のため、PSoC™キットを使用してデバッグ／プログラムおよびブートロードを簡単に実行できます。詳
細については、「CY8CKIT-040 Kit Guide」と「CY8CKIT-042 PSoC™ Pioneer Kit Guide」を参照してくだ
さい。 

http://www.cypress.com/?rID=38154&source=an86526
http://www.cypress.com/CY8CKIT-040
http://www.cypress.com/?rid=77780&source=an86526
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13 付録 F - キットの選択 
ターゲット デバイス キット名 ユーザー ガイド 
CY8C42xx CY8CKIT-042 PSoC™ 4 Pioneer Kit CY8CKIT-042  
CY8C40xx-S CY8CKIT-041-40xx PSoC™ 4 Sシリーズ Pioneer Kit CY8CKIT-041 
CY8C41xx-S CY8CKIT-041-41xx PSoC™ 4100S CapSense Pioneer Kit CY8CKIT-041 
CY8C40xx CY8CKIT-040 Pioneer Kit CY8CKIT-040  
CY8C41xx-PS CY8CKIT-147 PSoC™ 4100PS Prototyping Kit CY8CKIT-147 
CY8C4100S Plus CY8CKIT-149 PSoC™ 4100S Plus Prototyping Kit CY8CKIT-149 

 

 

  

http://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-psoc-4-pioneer-kit?source=search&keywords=cy8ckit-042
http://www.cypress.com/CY8CKIT-041
http://www.cypress.com/CY8CKIT-041
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-040-psoc-4000-pioneer-development-kit?source=search&keywords=cy8ckit040
http://www.cypress.com/cy8ckit-147
http://www.cypress.com/cy8ckit-149
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